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Tiết theo KHBD: ………

CHỦ ĐỀ E: ỨNG DỤNG TIN HỌC
SOẠN THẢO VĂN BẢN CƠ BẢN VÀ SƠ ĐỒ TƯ DUY
BÀI 5:  THỰC HÀNH TỔNG HỢP VỀ SOẠN THẢO VĂN BẢN
Thời gian thực hiện: (01 tiết)
I. Mục tiêu: SP Tin 6 Anh Nguyet + Pham Huy
1. Kiến thức: 
- Soạn thảo được văn bản phục vụ học tập và sinh hoạt hằng ngày.
- Nêu được các chức năng đặc trưng của những phần mềm soạn thảo văn bản.
2. Về năng lực:
2.1. Năng lực chung
Thực hiện bài học này sẽ góp phần hình thành và phát triển một số thành tố năng lực chung của học sinh như sau:
Năng lực tự chủ, tự học: Học sinh có khả năng tự đọc sách giáo khoa và kết hợp với gợi ý của giáo viên để trả lời câu hỏi 
Năng lực giao tiếp và hợp tác: HS phân công được nhiệm vụ trong nhóm, biết hỗ trợ nhau, trao đổi, thảo luận, thống nhất được ý kiến trong nhóm để hoàn thành nhiệm vụ.
Năng lực giải quyết vấn đề và sáng tạo: Học sinh đưa ra được thêm các ví dụ trong cuộc sống hằng ngày. 
2.2. Năng lực Tin học
Thực hiện bài học này sẽ góp phần hình thành và phát triển một số thành tố năng lực Tin học của học sinh như sau:
Năng lực A (NLa): 
- Phát triển năng lực sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông. Sử dụng đúng cách các thiết bị, các phần mềm thông dụng phục vụ phục vụ cuộc sống và học tập; bước đầu tạo ra được sản phẩm số phục vụ cuộc sống nhờ khai thác phần mềm ứng dụng. Ví dụ đơn xin phép nghỉ học, thời khoa biểu, bản quảng cáo,...
Năng lực C (NLc): 
- Năng lực giải quyết vấn đề với sự hỗ trợ của công nghệ thông tin và truyền thông. Tìm kiếm và đánh giá được sự phù hợp thông tin và dữ liệu với yêu cầu bài tập đặt ra; thao tác được với phần mềm
Năng lực D (NLd): 
- Năng lực ứng dụng công nghệ thông tin và truyền thông trong học và tự học. Sử dụng được một số phần mềm học tập. Thực hiện đươc các thao tác sử dụng phần mềm Microsoft Word cơ bản: Mở tệp văn bản mới, chọn cỡ giấy và căn lề, nhập nội dung, định dạng đoạn và trình bày văn bản, lưu và in văn bản; tạo được sản phẩm số đơn giản để phục vụ nhu cầu học tập, sinh hoạt hằng ngày (cụ thể là đơn xin nghỉ phép và thời khóa biểu).
Năng lực E (NLe):
- Năng lực hợp tác trong môi trường số. 
3. Về phẩm chất: 
Thực hiện bài học này sẽ góp phần hình thành và phát triển một số thành tố phẩm chất của học sinh như sau:
- Nhân ái: Thể hiện sự cảm thông và sẵn sàng giúp đỡ bạn trong quá trình thảo luận nhóm.
- Chăm chỉ: Thực hiện đầy đủ các hoạt động học tập một cách tự giác, tích cực.
- Trung thực: Thật thà, thẳng thắn trong báo cáo kết quả hoạt động cá nhân và theo nhóm, trong đánh giá và tự đánh giá.
- Trách nhiệm: Hoàn thành đầy đủ, có chất lượng các nhiệm vụ học tập.
II. Thiết bị dạy học và học liệu:
1. Thiết bị dạy học:
- Phấn, bảng, máy tính, máy chiếu, phiếu học tập, các công cụ hỗ trợ tổ chức trò chơi.
2. Học liệu:
- GV: SGK, SBT, tài liệu tham khảo
- HS: SGK, bảng nhóm, bút lông, bút dạ, phấn. 
III. Tiến trình dạy học:
	1. HOẠT ĐỘNG 1:  MỞ ĐẦU (7 phút).
a) Mục tiêu: 
Sau hoạt động này, học sinh có thể:
- Củng cố kiến thức về tác dụng của công cụ căn lề, định dạng, tìm kiếm, thay thế trong phần mềm soạn thảo văn bản đã được học. 
- Từ những câu hỏi củng cố, bước đầu nhận biết chức năng của từng công cụ: Tìm kiếm và Thay thế; Định dạng đoạn; Định dạng trang; Chọn số bản in và tên máy in.
- Tạo không khí lớp học thoải mái, học sinh có thể phát huy hết năng lực của mình. 
b) Nội dung: 
- Học sinh được củng cố các nhóm lệnh, thông qua hoạt động trò chơi trực tuyến.
c) Sản phẩm: Kết quả từ những câu hỏi củng cố, bước đầu nhận biết chức năng của từng công cụ: Tìm kiếm và Thay thế; Định dạng đoạn; Định dạng trang; Chọn số bản in và tên máy in.
d) Tổ chức thực hiện: Giao nhiệm vụ, học sinh thực hiện, đánh giá và nhận xét

	Hoạt động của GV và HS
	Tiến trình nội dung

	* GV giao nhiệm vụ học tập:
- Hãy tham gia trò chơi và trả lời 10 câu hỏi liên quan kiến thức về phần mềm soạn thảo đã được học. 
- GV: Yêu cầu từng bạn làm cá nhân, nghiêm túc, không trao đổi, để đánh giá kiến thức, kĩ năng, thái độ học của các bạn trong chủ đề phần mềm soạn thảo này. GV hướng dẫn HS truy cập đúng link bộ câu hỏi.
Hình ảnh mô phỏng:
[image: ]
HS: Nghe giáo viên hướng dẫn cách thức sử dụng trang web đúng cách và tham gia trò chơi nghiêm túc. 
Bộ câu hỏi:
Câu 1:
[image: ]
Câu 2:
[image: ]
Câu 3:
[image: ]
Câu 4:
[image: ]
Câu 5:
[image: ]
Câu 6:
[image: ]
Câu 7:
[image: ]
Câu 8:
[image: ]
Câu 9:
[image: ]
Câu 10:
[image: ]
* HS thực hiện nhiệm vụ
- GV: Quan sát các bạn tham gia trò chơi, trả lời câu hỏi.
- HS: Học sinh nghiêm túc tham gia trò chơi đến khi hết thời gian quy định.
* Báo cáo, thảo luận
- GV: Thông báo hết thời gian hoạt động nhóm. Gọi đại diện top 5 lên trao quà.
- GV: Phân tích các câu đặc biệt, trọng tâm đánh vào câu hỏi 3, 5, 6 
+ Câu 3: Công cụ tìm kiếm và thay thế.
+ Câu 5: Các nút lệnh liên quan đến định dạng đoạn văn bản.
+ Câu 6: Định dạng trang.
- HS: Lắng nghe, chú ý lời giảng của giáo viên.
* Kết luận, nhận định
- GV: Nhận xét, đánh giá chung cho kết quả hoạt động của lớp. 
- GV: Ở những chủ đề trước các em đã làm quen với tìm kiếm và thay thế trong soạn thảo văn bản; trình bày trang, định dạng và in văn bản; trình bày thông tin ở dạng bảng; để khắc sâu kiến thức và luyện tập những kiến thức và kĩ năng đó, tiết học hôm nay chúng ta sẽ cùng thực hành tổng hợp về soạn thảo văn bản.
	
Đáp án trò chơi:
Câu 1: Con trỏ.
Câu 2: 
Bảng chọn File  Lệnh New  Bank Document  Create
Câu 3: 
(1) nhập văn bản 
(2) Tìm kiếm 
(3) Thay thế
Câu 4:
- Trang văn bản.
- Đoạn văn bản.
- Dòng.
- Từ soạn thảo.
- Kí tự.
Câu 5:
[image: ]    [image: ]     [image: Icon

Description automatically generated]
Câu 6:
(1) trình bày trang văn bản 
(2) lề dưới 
(3) lề phải
Câu 7:
[image: ]
Câu 8:
[image: Graphical user interface

Description automatically generated]
Câu 9:
[image: ]
Câu 10:
Đà Nẵng quyết tâm - Chung tay đẩy lùi Covid-19












































































































	2. HOẠT ĐỘNG 2: HÌNH THÀNH KIẾN THỨC.
Hoạt động 2.1: Các chức năng đặc trưng của phần mềm soạn thảo văn bản (8 phút)
a) Mục tiêu: Tái hiện kiến thức về các chức năng đặc trưng của phần mềm soạn thảo văn bản 
b) Nội dung: Tìm công cụ phục vụ từng chức năng đặc trưng
c) Sản phẩm: Hoàn thành phiếu học tập
d) Tổ chức thực hiện: Giao nhiệm vụ, học sinh báo cáo, đánh giá và nhận xét


	Hoạt động của GV và HS
	Nội dung

	* GV giao nhiệm vụ học tập
- Thảo luận nhóm và đại diện nhóm trả lời, hoàn thành bài tập sau: Các chức năng đặc trưng của phần mềm soạn thảo văn bản là gì? Từ đó các e hãy hoàn thành phiếu học thực hành số 1.
- GV: Yêu cầu các nhóm hoàn thành nhiệm vụ học tập trong 4 phút.  
- HS: Quan sát và tiến hành hoạt động nhóm theo phân công trong vòng 4 phút.
* HS thực hiện nhiệm vụ
- GV: Quan sát các nhóm hoạt động, hỗ trợ các cá nhân hoặc nhóm gặp khó khăn. Có thể cho phép các em HS khá, giỏi hỗ trợ các bạn trong nhóm để hoàn thành nhiệm vụ nhanh hơn.
- HS: Các nhóm thảo luận, thống nhất kết quả ghi vào bảng nhóm, phân công thành viên nhóm chuẩn bị báo cáo kết quả khi hết thời gian quy định thảo luận nhóm.
* Báo cáo, thảo luận
- GV: Thông báo hết thời gian hoạt động nhóm. Gọi đại diện các nhóm lên báo cáo kết quả hoạt động.
- GV: Yêu cầu các nhóm khác nhận xét, đánh giá và chấm điểm chéo nhau theo phân công của GV. 
- HS: Nhận xét, đánh giá kết quả hoạt động của nhóm khác.
* Kết luận, nhận định
- GV: Nhận xét, đánh giá chung cho kết quả hoạt động của các nhóm.
	Bài 1: Tìm công cụ phục vụ từng chức năng đặc trưng.
   Em hãy ghép các cột A với cột B để được các chức năng đặc trưng của phần mềm soạn thảo văn bản:

PHIẾU THỰC HÀNH SỐ 1    Họ Tên:
	A
	B

	Công cụ
	Chức năng đặc trưng

	Tìm kiếm và Thay thế
	Nhập và lưu văn bản

	định dạng đoạn
	Trình bày văn bản

	định dạng trang
	Sửa đổi văn bản

	chọn số bản in và tên máy in
	In văn bản


Đáp án
	A
	B

	Công cụ
	Chức năng đặc trưng

	Tìm kiếm và Thay thế
	Nhập và lưu văn bản

	định dạng đoạn
	Trình bày văn bản

	định dạng trang
	Sửa đổi văn bản

	chọn số bản in và tên máy in
	In văn bản




	Hoạt động 2.2: Sử dụng các công cụ và trình bày trang in (9 phút) 
a) Mục tiêu: Biết sử dụng các công cụ và trình bày trang in
b) Nội dung: Soạn thảo đơn xin phép nghỉ học, thực hiện định dạng trang, định dạng kí tự, định dạng đoạn theo mẫu
c) Sản phẩm: Đơn xin phép được định dạng đẹp và hợp lý 
d) Tổ chức thực hiện: Giao nhiệm vụ, học sinh báo cáo, đánh giá và nhận xét

	Hoạt động của GV và HS
	Tiến trình nội dung

	* GV giao nhiệm vụ học tập
- GV trình chiếu Đơn xin phép nghỉ học (mẫu), yêu cầu hs thực hiện các nhiệm vụ sau: 
Câu 1: Để được văn bản đẹp và hợp lí ta tùy chọn những thuộc tính nào cho các định dạng?
Câu 2: Em hãy nêu các bước để thực hiện soạn thảo đơn xin phép nghỉ học (mẫu), sau đó thực hiện soạn thảo đơn xin phép nghỉ học trên máy.
Câu 3: Lưu tệp với tên tệp là “Đơn xin phép nghỉ học” và in ra.
- GV quy định mỗi máy tính là một nhóm, mỗi nhóm gồm 2, 3 học sinh. 
- GV: Yêu cầu các nhóm hoàn thành nhiệm vụ học tập trong 6 phút.
- HS: Quan sát và tiến hành hoạt động nhóm theo phân công trong vòng 6 phút.
* HS thực hiện nhiệm vụ
- GV: Quan sát các nhóm hoạt động, hỗ trợ các các nhân hoặc nhóm gặp khó khăn. Có thể cho phép các em HS khá, giỏi hỗ trợ các bạn trong nhóm để hoàn thành nhiệm vụ nhanh hơn. 
- HS: Các nhóm thảo luận, thống nhất kết quả luận ghi vào bảng nhóm, phân công thành viên nhóm chuẩn bị báo cáo kết quả khi hết thời gian quy định thảo luận nhóm.
* Báo cáo, thảo luận
- GV: Thông báo hết thời gian hoạt động nhóm. Gọi đại diện các nhóm lên báo cáo kết quả hoạt động.
- GV: Yêu cầu các nhóm khác nhận xét, đánh giá và chấm điểm chéo nhau theo phân công của GV. 
- HS: Nhận xét, đánh giá kết quả hoạt động của nhóm khác.
* Kết luận, nhận định
- GV: Nhận xét, đánh giá chung cho kết quả hoạt động của các nhóm. Chốt nội dung kiến thức chính: 
Bài 2: Sử dụng các công cụ và trình bày trang in trang 70 SGK
	2. Sử dụng các công cụ và trình bày trang in:
Bài 2: Soạn thảo đơn xin phép nghỉ học 
[image: ]
Thực hiện các bước như sau: 
+ Bước 1: Mở tệp văn bản mới 
+ Bước 2: Chọn cỡ giấy và căn lề
+ Bước 3: Nhập nội dung
+ Bước 4: Định dạng đoạn và trình bày văn bản 
+ Bước 5: Lưu và in văn bản 


	Hoạt động 2.3: Tạo bảng trong văn bản (8 phút) 
a) Mục tiêu: Soạn thảo được văn bản phục vụ học tập và sinh hoạt hằng ngày 
b) Nội dung: Soạn thảo thời khóa biểu của em theo mẫu, in thời khóa biểu 
c) Sản phẩm: Tạo thời khóa biểu như mẫu, trang trí bảng hợp lý.
d) Tổ chức thực hiện: Giao nhiệm vụ, học sinh báo cáo, đánh giá và nhận xét

	Hoạt động của GV và HS
	Nội dung

	* GV giao nhiệm vụ học tập
- Thảo luận nhóm và đại diện nhóm trả lời, hoàn thành bài tập sau: GV trình chiếu một thời khóa biểu (mẫu), yêu cầu hs thực hiện các nhiệm vụ sau: 
Câu 1: Tạo thời khóa biểu của em theo mẫu và đặt tên tệp là “Thời khóa biểu”, tô màu chữ, màu nền cho bảng.
Câu 2: In thời khóa biểu
Câu 3: Có những cách nào em biết được có bốn tiết môn Toán trong một tuần
- GV: Yêu cầu các nhóm hoàn thành nhiệm vụ học tập trong 6 phút.
- HS: Quan sát và tiến hành hoạt động nhóm theo phân công trong vòng 6 phút
* HS thực hiện nhiệm vụ
- GV: Quan sát các nhóm hoạt động, hỗ trợ các cá nhân hoặc nhóm gặp khó khăn. Có thể cho phép các em HS khá, giỏi hỗ trợ các bạn trong nhóm để hoàn thành nhiệm vụ nhanh hơn. 
- HS: Thực hành tạo sản phẩm đích và đánh dấu () vào các công việc đã hoàn thành trong  phiếu thực hành số 2.
* Báo cáo, thảo luận
- GV: Thông báo hết thời gian hoạt động nhóm. Gọi đại diện các nhóm lên báo cáo kết quả hoạt động.
- GV: Yêu cầu các nhóm khác nhận xét, đánh giá và chấm điểm chéo nhau theo phân công của GV. 
- HS: Nhận xét, đánh giá kết quả hoạt động của nhóm khác.
- GV: Chiếu lên một số bài đẹp, hợp lý
* Kết luận, nhận định
- GV: Khen ngợi và nhận xét hoạt động cũng như sản phẩm của một số nhóm làm tốt, một số nhóm chưa tốt cần cố gắng. GV ghi chép về đánh giá thường xuyên đối với một số cá nhân HS cần quan tâm theo dõi sự tiến bộ trong học tập. Chốt nội dung kiến thức chính: 
Bài 3: Tạo bảng trong văn bản trang 71 SGK
	3. Tạo bảng trong văn bản
Bài 3: Soạn thảo thời khóa biểu của e
Bước 1: Tạo bảng mới
- Viết hai dòng tiêu đề của bảng, định dạng phông cho các dòng này
[image: ]
- Chèn hàng, xác đinh bảng gồm số hàng, số cột theo thời khóa biểu
Bước 2: Nhập nội dung cho bảng.
Bước 3: Định dạng bảng và căn biên
- Thay đổi độ rộng cho phù hợp, căn biên giữa các nội dung tất cả các ô.
Bước 4: Trang trí lại bảng.
- Chèn ảnh vào bảng để bảng hấp dẫn hơn.
Bước 5: Sử dụng công cụ tìm kiếm để xem có bao nhiêu từ ‘Toán’
Bước 6: Lưu và in văn bản.
PHIẾU THỰC HÀNH SỐ 2 
	TT
	Công việc
	Xác nhận
hoàn
thành

	1
	Làm việc với tệp văn bản
- Mở tệp mới.
- Đặt tên tệp là “Thời khóa biểu của em”.
	

	2
	Chuẩn bị nguồn giấy và căn lề
- Giấy khổ A4.
- Các lề trang là 2,54 cm.
	

	3
	Nhập nội dung
- Phông Times New Roman.
- Cỡ chữ: 14.
	

	4
	Định dạng đoạn và trình bày đơn
- Căn biên đầu hai bên.
- Dãn dòng 1,5
	

	5
	Lưu và in văn bản
- Đã kiểm tra văn bản được lưu vào đúng thư mục quy định
	

	6
	Điểm tự chấm
	

	7
	Điểm nhóm bạn chấm
	

	8
	Điểm trung bình
	




	3.  HOẠT ĐỘNG 3: LUYỆN TẬP (8 phút) 
a) Mục tiêu: Khắc sâu kiến thức đã học 
b) Nội dung: Các câu hỏi trắc nghiệm 
c) Sản phẩm: Kết quả trả lời đúng các câu hỏi trắc nghiệm
d) Tổ chức thực hiện: 

	Hoạt động của GV và HS
	Tiến trình nội dung

	* GV giao nhiệm vụ học tập
- GV chia lớp thành nhiều nhóm
(mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập
Câu 1: Để khởi động phần mềm MS Word, ta thực hiện:
A. Nháy chuột vào Start → All Programs → Microsoft Word
B. Nháy chuột phải vào biểu tượng trên màn hình nền
C. Nháy chuột trái vào biểu tượng trên màn hình nền
D. Cả A và C
Câu 2: Muốn lưu văn bản vào đĩa, ta thực hiện:
A. Edit → Save…    B. Insert → Save…    C. File → Save…     D. Edit → Save
Câu 3: Tên tệp do Word tạo ra có phần mở rộng là gì? 
A. .TXT                  B. .COM   
 C. .EXE                  D. .DOCX
Câu 4: Trong soạn thảo văn bản nhấn Enter một lần để?
A. Phân cách giữa các kí tự
B. Phân cách giữa các từ
C. Phân cách giữa các đoạn
D. Phân cách giữa các trang.
Câu 5: Trong các phông chữ dưới đây, phông chữ nào dùng mã Unicode?
A. VNI-Times    B. VnArial   
C. VnTime         D. Time New Roman
Câu 6: Giữa các từ dùng mấy kí tự trống để phân cách?
	A. 1    
	B. 2
	C. 2    
	D. 4


- GV: Yêu cầu các nhóm hoàn thành nhiệm vụ học tập trong 5 phút
- HS: Quan sát và tiến hành hoạt động nhóm theo phân công trong vòng 5 phút.
 * HS thực hiện nhiệm vụ
- GV: Quan sát các nhóm hoạt động, hỗ trợ các các nhân hoặc nhóm gặp khó khăn. Có thể cho phép các em HS khá, giỏi hỗ trợ các bạn trong nhóm để hoàn thành nhiệm vụ nhanh hơn. 
- HS: Các nhóm thảo luận, thống nhất kết quả luận ghi vào bảng nhóm, phân công thành viên nhóm chuẩn bị báo cáo kết quả khi hết thời gian quy định thảo luận nhóm
* Báo cáo, thảo luận
- GV: Thông báo hết thời gian hoạt động nhóm. Gọi đại diện các nhóm lên báo cáo kết quả hoạt động.
- GV: Yêu cầu các nhóm khác nhận xét, đánh giá và chấm điểm chéo nhau theo phân công của GV. 
- HS: Nhận xét, đánh giá kết quả hoạt động của nhóm khác.
* Kết luận, nhận định
- GV: Nhận xét, đánh giá chung cho kết quả hoạt động luyện tập thực hành các bài tập của các nhóm.
	* Trắc nghiệm: 
1. D
2. C
3. D
4. C
5. D
6. A

	4. HOẠT ĐỘNG 4: VẬN DỤNG (5 phút)
a) Mục tiêu hoạt động: Giúp học sinh vận dụng các kiến thức đã được học ứng dụng vào cuộc sống
b) Nội dung: Tạo thiệp sinh nhật
c) Sản phẩm: Tạo được thiệp sinh nhật 
d) Tổ chức thực hiện: 

	Hoạt động của GV và HS
	Tiến trình nội dung

	* GV giao nhiệm vụ học tập
- Sắp tới sinh nhật bạn An, các em hãy giúp bạn An tạo một thiệp sinh nhật đẹp để chúc mừng sinh nhật bạn.
- GV giao nhiệm vụ cho học sinh thực hiện tại nhà, gửi email cho cô và báo cáo kết quả thực hiện vào giờ sau
* HS thực hiện nhiệm vụ
- Tiếp nhận nhiệm vụ
* Báo cáo, thảo luận
- Báo cáo kết quả vào giờ sau
* Kết luận, nhận định
- Giáo viên nhận xét, dặn dò
	Nội dung: Học sinh về nhà thực hiện: 
+ Tạo thiệp sinh nhật
+ Thực hiện thao tác gửi email cho GV  và một nhóm HS trong lớp về nội dung bài học hôm nay
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